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	 Multiple talker interface for use with the NMEA 0183 standard. Serial data 
networking of marine electronic devices / instruments. 

	 RS232 & USB 1.1 & 2.0 PC interfaces to the NMEA 0183 standard.

	 Actisense ISO-Drive technology for a fully isolated serial data system.

	 Intelligent NMEA filtering on all inputs allows smart removal of NMEA data.

	 Reconfigurable to work as an NDC-4-ASW Autoswitch to allow the automatic 
switching between upto 4 NMEA inputs.
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Important Notices
Actisense and the Actisense logo are registered trademarks 
of Active Research Limited. All rights are reserved. The 
contents of this manual may not be transferred or copied 
without the expressed written permission of Active 
Research Limited. All other trademarks are the property of 
their respective owners. 

The Actisense NMEA Data Multiplexer / Combiner / 
Autoswitch (NDC-4) is intended for use in a marine 
environment, primarily for below deck use. If the unit is to 
be used in a more severe environment, such use may be 
considered misuse under the seller’s warranty.

The Actisense NMEA Data Multiplexer (NDC-4) has been 
certified to comply with the European directive for Electro-
Magnetic Compatibility (EN60945), and is appropriately 
CE marked.  Operation of the unit should be in conjunction 
with appropriate CE approved shielded connectors 
and cabling used in accordance with the CE directive 
EN60945.  Any EMC related issues should be reported 
to Active Research immediately to allow the company to 
rectify or resolve EMC related problems in accordance 
with its obligations under EN60945.

If the unit is connected such that compliance failure occurs 
beyond the company’s control, the company shall not be 
held responsible for compliance failure until suitable EMC 
guidelines for connection are seen to have been taken.

Notices
When using this document, keep the following in mind:

The products described in this manual and the specifications 
thereof may be changed without prior notice.  To obtain up-
to-date information and/or specifications, contact Active 
Research Limited or visit the Actisense website (www.
actisense.com).

Active Research Limited will not be liable for infringement 
of copyright, industrial property right, or other rights of a 
third party caused by the use of information or drawings 
described in this manual.

Active Research Limited will not be held responsible for 
any damage to the user that may result from accidents 
or any other reasons during operation of the user’s unit 
according to this document.

The NDC-4 does not validate the NMEA data it receives 
in any way. Neither the NMEA sentence checksum, nor 
the data contained within the NMEA sentence is validated. 
Therefore, the electronic device(s) supplying the NDC-4 
with NMEA data retain(s) the sole responsibility for the 
NMEA data’s validity.

Foreword
Actisense recognises that instructions are often skipped, 
so we have aimed to write this document in an informative, 
yet direct manner that will aid the user. We have tried to 
cover all the points a typical user may need to know.  Please 
read all sections before installing and using the Actisense 
NMEA Data Multiplexer product and any related software 
programs.

Introduction
The Actisense NMEA Data Multiplexer (NDC-4) product 
developed out of the requirement to solve two fundamental 
problems with the existing marine industry NMEA 0183 
communications standard. 

In theory, the NMEA 0183 standard allows any suitably 
designed marine electronic device to share its gathered 
information with any other device on a vessel. Unfortunately, 
there is one very large drawback with this standard - only 
one device on a connected network can actually send 
data (a single talker), with multiple devices (determined by 
the current limit of the sending unit) listening to that data 
(multiple listeners). 

If the vessel owner has an instrument that ideally requires 
the data output of two or more devices, for example a chart 
plotter, then the owner has no alternative but to settle on 
connecting only the most important device (that which 
supplies the most used information), normally that is the 
GPS unit. All other devices cannot be used.

What happens if the owner prefers the vessels gyro 
compass heading output to that of the GPS, or requires 
that the current depth be displayed on the plotted chart to 
help avoid the possible case of running the vessel aground 
on a shifting sand bank? The NMEA 0183 standard cannot 
supply an answer to those questions as it can handle only 
one transmitting device.

These two elementary problems can be solved simply and 
easily with the Actisense NMEA Data Multiplexer’s very 
flexible design approach.

Alternately, if the vessel has two or more identical NMEA 
devices (e.g. GPS’s or depth sounders) the system 
solution could be to use the Actisense NDC-4 as an 
NMEA Autoswitch to select the highest priority source.

Full information on the complete Actisense product range 
can be found on the Actisense website.

http://www.actisense.com
http://www.actisense.com
http://www.actisense.com
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General features
4/5 Opto-isolated input ports
Each Opto-isolated input port has a priority level. This 
defaults to the logical order matching the port numbers, i.e. 
port 1 has the highest priority and port 4 has the lowest. 
If the USB cable is not plugged in (or not powered) and  
OPTO IN 0 is not used to connect to a PC, OPTO IN 0 can 
be used as a fifth fully compliant NMEA 0183 data input.

2 ISO-Drive output ports
These outputs combine the input data into standard 
NMEA outputs. If the combined Baud rate of all NMEA 
inputs exceed the output Baud rate, it is possible that the 
combined data could exceed the data carrying capacity 
of the NMEA output channel. The multiplexer contains 
special software to ensure that when the output channel is 
overloaded, new data of the same type as older data, still 
in the buffer, will overwrite the older sentence. 

A PC RS232 or USB bi-directional port
The RS232 compatible Port 0 (OPTO IN 0 plus ISO 
OUT 0) and the USB interface ensures that any device 
(or PC), that has an RS232 or USB port, receives all the 
input NMEA data, and can add its own NMEA data to the 
combined output. This allows for the possibility of a “virtual 
cockpit” of instruments displaying all available data in any 
manner the user requires (available from a number of 
manufacturers). 

These connections also allow the unit to be updated via 
the freely available ActiPatch flash upgrade software that 
will be made available on the Actisense website when the 
NDC-4 firmware has been enhanced.

When the USB cable is plugged in and powered up, it 
disables the OPTO IN 0 on the NDC. For example this 
is very useful when a PC is supplying data, and you 
want an NMEA device to supply the same data when 
the PC is powered down.

Note that standard NDC-4 units can be upgraded to USB 
by purchasing a USB upgrade kit.

Technical features
High-speed 32-bit ARM processor capable of up to 40 
million instructions per second.

Flash ROM technology that supports automatic 
programming for quick and easy updates, 100,000+ erase 
cycles and a 10-year Data Retention provides carefree 
user configuration. 

On-chip memory store allows buffering of short-term 
NMEA data, allowing the unit to smooth short-term peaks 
in the NMEA data flow.

The NMEA 0183 inputs are floating receivers, opto-
isolated to 2500 volts, protecting your system even during 
the most extreme fault conditions. This differential input is 
fully compliant with the NMEA 0183 standard specification 
and is also compatible with RS232 signal levels.  Typical 
operating voltage is 2.0v to 15.0v. The unit can withstand 
+/- 35v continuously, and +/- 40v transients. The Opto-
isolator can thus protect any upstream equipment (chart 
plotter, laptop PC, radar etc.) from up to 2500v of common 
mode voltage difference.

ISO-Drive output technology creates a driver, unique to 
Actisense, that is isolated to 1500 volts. ISO-Drive allows 
a completely floating output to be created, making a safe 
connection to a PC an easy task. The output automatically 
changes between differential and single ended drive 
depending upon the type of instrument it is connected to. 
The ISO-Drive output is fully compliant with the NMEA 
0183 standard specification and is also compatible with 
RS422 & RS232 signal levels.

Wide battery input voltage range to offer maximum 
compatibility, the NMEA 0183 NDC-4 can operate from a 
battery supply anywhere between 8 and 35 volts.

USB powered option is available when the battery source 
is not present. When the main battery is present, the USB 
power drain is minimal.

A diagnostic LED indicates the operation mode of the 
NDC-4, if any faults have been detected, or the peak load 
currently on any one of the NMEA inputs. 

Very tough Polycarbonate case is certified to IP66  
(splash-proof). Being Polycarbonate, it is also incredibly 
strong, offering a wide temperature range and superior 
protection to the electronics inside. 

Robust Nylon grommets are certified to IP68 
(submersible). Note that to achieve this level of water 
integrity all grommets must be occupied by round-section 
cables of between 4.5mm and 10mm diameter.

Large range of possible cable diameters of between 
4.5 mm and 10 mm, single or multi-pair wire types can be 
easily accepted.

Software updates
The NDC-4’s built-in firmware is held in “flash” memory, 
allowing quick and easy upgrades using a simple Microsoft 
Windows (98 SE/ME/NT/2000/XP) user interface program 
(ActiPatch) running on a connected PC.

It is our policy to provide these updates free on our website, 
www.actisense.com. This upgrade can be performed 
with the unit completely in-situ, via a PC connected to the 
Port 0 (OPTO IN 0 and ISO OUT 0) or the USB port.

http://www.actisense.com
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Connecting devices together
The basics
NMEA data is transmitted from an information source such 
as GPS, depth sounder, gyro compass etc. These data 
sending devices are called “Talkers”.

Equipment receiving this information such as a chart-
plotter, radar or NMEA display is called a “Listener”. 

Unfortunately, only one Talker can be connected on to a 
single NMEA 0183 system at any one time. Two or more 
Talkers are simply not possible because they are not 
synchronised to each other, and will attempt to ‘talk’ at 
the same time (over each other), resulting in corruption of 
the NMEA data, and potentially in disaster if valuable data 
such as navigation information is lost or corrupted so that 
it is incorrect and/or misleading.

Actisense produces a full range of products to solve all 
NMEA interfacing requirements.

Please visit the Actisense website for full details on 
these and other Actisense interfacing, Depth sounding 
and Sonar products.

The NMEA signals
The NMEA 0183 system v2.0 and later uses a ”differential” 
signalling scheme, whereby two wires are used to transmit 
the NMEA data. These connections will be labelled as 
either NMEA “A” and “B“ or NMEA “+” and “-“ respectively, 
depending on the instrument and manufacturer.

When connecting between different manufacturers, there 
can be some confusion, but it is simple and easy to 
remember: NMEA “A” connects to NMEA “+” and NMEA 
“B“ connects to NMEA “-“.

The different NMEA standards
The NMEA 0183 specification has slowly evolved over the 
years, so connecting one device to another is not always a 
straightforward matter. The earlier versions of NMEA 0183 
(before v2.0, as detailed above), used slightly different 
connection methods and signal levels: the instruments 
had just one “NMEA” data line (‘Tx’ or ‘Out’), and used  
the ground as the other line - similar to the way a computer 
serial port works. This connection method is referred to as 
“single ended” instead of the “differential” method used by 
NMEA 0183 v2.0 devices.

The data format is largely the same between both 
systems, with v2.0 adding some extra sentence strings, 
and removing older (redundant) sentence strings from the 
specification. The situation is further complicated, as many 
manufacturers still use the old (“single ended”) method of 
connection because it is cheaper to implement.

So how can an older type NMEA device be connected to a 
newer type device?

Care is needed – it is possible to damage or overload 
the output of a newer differential device if it is incorrectly 
connected to an older device. This is because the older 
devices used ground as the return, whereas the newer 
devices actually drive the NMEA “-/B” line between 5v and 
0v. Thus, connecting this output to ground will result in high 
currents being drawn by the driver instrument, resulting in 
potential overheating and damage to the driver circuits.

However, the new Actisense ISO-Drive technology 
allows the user not to worry about this potentially 
damaging  incompatibility.  Instead, an ISO-Drive output 
can be connected to an old type single-ended system, by 
connecting the NMEA “+/A” output from the ISO-Drive to 
the single-ended NMEA “Rx” or “In” input of the device. 
Connect the NMEA “-/B” output of the ISO-Drive to the 
ground of the single-ended device. This provides the 
required data signal return current path.

To connect an old type single-ended device to an OPTO 
IN input, connect the NMEA ”Tx” or “Out” output from the 
single-ended driver to the OPTO IN “+/A” input of the NDC. 
Connect the ground line of the single-ended output device 
to the OPTO IN “-/B” input of the NDC. This provides the 
data signal return current path. If the NMEA “-/B” input is 
left floating, then data corruption / errors may occur.

Please refer to the Output Connections section for 
example of these connection methods.

http://www.actisense.com
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1.	 Five Opto-isolated inputs.
All inputs are of the differential opto-isolated type and 
use the unique Actisense low current drain circuitry 
(2mA @ 2.0v) to conform in full with the NMEA 0183 
marine electronic device network communication 
standard, and are flexible enough to interface to most 
fully and partially compliant devices.

2.	 Two ISO-Drive outputs.
The ISO-Drive outputs comprise of two connections: 
‘+/A’ and ‘-/B‘ and conform in full to the NMEA 0183 
standard. 

3.	 RS232 compatible input/output option.
The ISO OUT 0 and OPTO IN 0 connections can 
be used as a bi-directional RS232 compatible port 
and is designed for direct connection to a Personal 
Computer (PC) or other marine device capable of 
interfacing to a standard RS232 port. 

When a USB cable is powered and plugged into the 
NDC-4, this port switches to output only - i.e. the 
RS232 input (OPTO IN 0) no longer operates.

4.	 A USB input/output (NDC-4-A-USB Only).
The standard USB 1.1 port is designed for direct 
connection to a PC’s USB port. Once the USB cable 
is powered and plugged into the NDC-4, Port 0 
switches to an output only mode - this allows the USB 
port to take over bi-directional control of the NDC-4.

USB 2.0 is backwardly compatible with USB 1.1.

5.	 Battery supply input.
Standard battery power connections.

Note:
1.	 To complete the NMEA 0183 standard all device 

interconnection NMEA cables used should meet the 
two-conductor, shielded, twisted pair configuration 
specification. The shield connection of these wires 
should be connected at the instrument end only to 
prevent ground loops.

2.	 Refer to the Specifications section for the full details 
on input/output specifications.

The NMEA Data Multiplexer (NDC-4) has screw-terminal “Phoenix” type external connections for: -

Connections

Figure 1 – All external connections
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OPTO Inputs
The differential opto-isolated inputs are designed to handle 
a variety of NMEA 0183 device output specifications. 
Please determine (from device manufacturer’s 
information) if the device(s) required to be connected 
to the Actisense NDC-4 conforms in full to the NMEA 
0183 network communication standard. If it does not, the 
flexible Actisense NDC-4 inputs should still be capable of 
interfacing with the device, though this is not guaranteed.  

The diagram above shows a typical installation with both 
fully compliant NMEA devices with differential inputs/
outputs, and non-differential output devices.

NMEA Talker devices 1, 2 and 4: These devices 
conform in full to the NMEA 0183 standard. Devices 1 
and 4 share the same connection ID’s as the Actisense 
NDC, so connection is a simple matter of matching 
the ID’s (refer to figure 2). Device 2 uses the RS485 
convention connection ID’s. Simply connect ‘A‘ to ‘+/A‘ 
and ‘B’ to ‘ -/B’ (refer to figure 2).

NMEA Talker device 3: This device does not conform 
completely to the NMEA 0183 standard. However, by 
connecting ‘+‘ to ‘+/A‘ and its ‘G/Ground’ to the NDC “-
/B” the NDC should receive the NMEA data correctly.

ISO-Drive Outputs
The ISO-Drive outputs are capable of driving up to 10 
NMEA 0183 fully compliant listening devices, or a mixture 
of NMEA 0183 devices and a Personal Computer (PC) 
communication port. However, if you wish to maintain 
isolation between all devices, then only one listening 
device should be connected to an ISO-Drive output.

NMEA Listener device’s B and C: These devices 
conform in full to the NMEA 0183 standard and their 
connection ID’s match that of the NDC.

Personal Computer: Whilst the OPTO IN 0 and ISO-
Drive 0 provide a bi-directional RS232 compatible 
port  for connection to a PC, the ISO-Drive 1 output 
is also capable of being read by a PC’s RS232 port. 
Simply connect ‘+/A’ to ‘Rx’ and ’-/B’ to ‘G/Ground’ on 
a standard D-type (probably male) connector.

NMEA Listener device A: This device does not 
conform in full to the NMEA 0183 standard. However, 
by connecting ‘+/A‘ to ‘+‘ and ‘-/B’ to ‘G/Ground’ the 
device should be able to receive the NMEA data 
correctly, though this is not guaranteed.

Note: 
1. 	 Wire colours are for guidance only. 

Connecting to NMEA devices

Figure 2 – NMEA 0183 connections
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Other Connections

Figure 3 – RS232, USB and Battery connections

Connecting to a Personal Computer
The USB port can be used to connect a PC to the NMEA 
0183 system. 

The NDC-4 should be used with the 2 metre USB cable 
supplied as standard. If a longer cable length is required, 
a standard USB 1.1/2.0 extension cable should be used 
in conjunction with the existing USB cable. This extension 
cable would have female ‘A’ and male ‘A’ connectors.

Alternatively, Port 0 (OPTO IN 0 and ISO OUT 0) can 
be used to connect a PC into the NMEA 0183 system 
by using a serial port cable conforming to the following 
specification:

1.	 A D-type female (socket) connector for the PC end of 
the cable.

2.	 A minimum of 3 cores are required in a shielded cable. 
Higher quality cable will yield higher performance 

(SNR). Most typical cables have two twisted pairs 
inside. In this case, use one pair for the TX line and 
one for the RX line. Use the spare wire in each pair 
as ground, and connect the cable shield to ground 
only at the computer end. Please note that both the 
Rx and Tx grounds on the NDC-4 must be connected 
to the PC’s ground, as shown in figure 3 above. 

3.	 The TX of the NDC-4 should be connected to the 
RX of the computer (standard D-type, pin 2) and 
the NDC-4 RX should be connected to the TX of the 
computer (pin 3). The GND of the NDC-4 should be 
connected to the PC’s serial port ground (pin 5).

Connecting to the battery supply
The Actisense NDC-4 can be powered either by the USB 
connection or through an external power source. If both 
power sources are available, the current drawn from the 
USB supply will be reduced to a trickle. If the external 
power source is removed, the USB power will seamlessly 
take over, without loss of data.

If the NDC-4 is powered from an external power source, like 
a battery, it should be wired to the vessel’s battery supply in 
the most direct manner possible, to minimize interference 
from other electronic devices. The cable used should be of 
sufficient gauge to handle the power requirements of the 
Actisense NDC-4 (refer to the Specifications sections).

Note: 
1.	 Wire colours are for guidance only. 

Battery / 
Power Supply 

+ - 
PC or 

Laptop 

USB 
PC or 

Laptop 

RxTx G

CAUTION!

The USB power and battery power are NOT 
isolated from each other. The USB and external 
battery should NOT be connected at the same time 
unless an isolated power supply is used.

For installs where the NDC-4 must still operate 
when the PC is switched off, full PC isolation can 
be maintained by using Port 0 (‘OPTO IN 0’ and ‘ISO 
OUT 0’) as the PC connection.

!
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USB Driver Installation
(NDC-4-A-USB Only - Note standard NDC-4 units can be 
upgraded to USB by purchasing a USB upgrade kit).

The Actisense NDC-4 makes use of a virtual serial port 
driver (know as the Virtual COM Port Driver) to interface 
between the USB port on the PC and the Actisense 
product. This driver allows software running on a PC 
to communicate with the Actisense NDC-4 as if it was 
connected to a standard serial port on the PC, when in fact 
all communication is done over the USB connection.

The required driver installation comes in two separate 
packages. The first driver is a called the ‘Serial Converter’ 
which converts the USB data packets to a serial data 
stream. The second driver, called the ‘Actisense NDC 
USB Serial Port’, makes the USB connection appear as a 
COM port in the Windows™ Device Manager. 

The NDC-4 with USB connection has been extensively 
tested with both Windows™ XP and Windows™ 98 SE.

For the experienced Windows™ XP user who is used to 
installing drivers, this section will be very familiar. To all 
other Windows™ users, the required steps are detailed 
below to help with installation.

The steps for Windows™ 98 SE are very similar to those 
of Windows™ XP and so are not detailed here.

The Actisense CD also contains the USB drivers for 
Windows™ 2000. These drivers have not been tested by 
Actisense, but should operate in the same manner as the 
Windows™ 98 SE and XP drivers.

The required Linux drivers are already included in the Linux 
kernels from v2.4.20 and onwards. However, Actisense 
has not been able to test the compatibility of the NDC-4 
with USB and this driver. 

For MAC OS 8, 9, and X please contact Actisense for 
details (refer to the Contact Information section).

Step by step guide
1. Connect the Actisense NDC-4 to an available USB 
port on the PC. The standard Windows™ ‘Found New 
Hardware Wizard’ window will then appear.

Select the ‘No, not this time’ option, to allow driver 
installation from the Actisense CD which was supplied 
with your Actisense product.

2. Insert the Actisense CD, choose the ‘Install from a list 
or specific location’ option, and click ‘Next’.
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3. Make sure the ‘Include this location in the search’ 
option is ticked, and use the ‘Browse’ button to locate the 
‘USB Drivers’ directory on the Actisense CD.

4. The ‘Actisense NDC USB Serial Converter’ driver is 
not Microsoft Windows™ certified, but it has been ‘tried 
and tested’ for stable and reliable operation with the 
Actisense NDC-4. Click ‘Continue Anyway’ to carry on 
with the installation.

5. The ‘USB Serial Converter’ driver is now installed, click 
‘Finish’ to complete the wizard, and wait for the ‘Found 
New Hardware Wizard’ to appear again.
 

This second wizard will guide you through the ‘USB Serial 
Port’ driver installation.

6. Follow steps 1 to 5 above for the ‘USB Serial Port’ 
driver installation and click ‘Finish’ to complete.

‘Your new hardware is installed and ready to use’ 
will appear in the bottom right corner of your screen 
when the installation is complete. See the USB Driver 
Configuration section for details on how to find out which 
COM port number has been allocated to your Actisense 
device as well as how to change to a different COM port 
and configure the Baud rate.
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USB Configuration
To communicate with the NDC-4, the COM port number 
that Windows™ has allocated to the USB port needs to be 
determined. The following guide will walk the user through 
this standard operation.

The Actisense NMEA Data Multiplexer, NDC-4 is 
completely USB port independent: it can be easily 
unplugged from one USB port and connected to another 
available USB port on the same PC without the COM Port 
number changing.

This is very useful when the NDC-4 is working in unison 
with a software program that is set up to use a particular 
COM port, as the user does not need to reselect a 
different COM port everytime the PC reboots, or the cable 
is swapped between two USB ports.

Step by step guide
1. Make sure the Actisense NDC-4 is powered up 
(indicated by a green LED) and connected to an available 
USB port on the PC. From the Windows™ ‘Control 
Panel’, open the ‘System Properties’ window and click 
on the ‘Hardware’ tab.

2. Click on ‘Device Manager’ and expand the ‘Ports (COM 
& LPT)’ list by clicking on the ‘+’ sign next to it. You will find 
the ‘Actisense NDC USB Serial Port’ in the list, followed 
by the allocated COM port number.  

3. Double click on the port icon for the ‘Actisense NDC 
USB Serial Port’ and the port properties window will 
appear. Click on the ‘Port Settings’ tab. Select a Baud 
rate of 38400 for the ‘Bits per second’ option. This is the 
fixed Baud rate for the Actisense NDC-4 device. Leave 
the other settings as they are.

4. Click on the ‘Advanced’ button and choose a different 
COM Port number if required (to make it compatible with 
the software requiring the NDC-4 NMEA data).

The other settings are already optimised for the Actisense 
NDC-4 and should be left in the default values. Click on 
‘OK’ button to save the new settings.
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Actisense PC Software suites
The Actisense NMEA Data Combiner hardware can be configured, monitored and tested using its own dedicated 
Control Centre software suite. The Actisense NDC can be updated / upgraded using the latest Flash Centre software 
suite. This section provides a complete users guide to installing and uninstalling these two software suites.

These programs are currently only available for Windows™ platforms (98 SE/ME/NT/2000/XP), however, it has been 
proven possible to use the NDC Control Centre / ActiPatch on a Mac running Windows emulation software.

To install Actisense PC software
Replace the generic “<Product Name>” text below with 
the name of the actual software you are installing: “NDC 
Control Centre”, or “ActiPatch”.

1.	 Download the latest version of the software from 
the Actisense website, or locate the files on the 
Actisense CD included with the NDC-4.

2.	 If a previous version of the software has already been 
installed, uninstall the previous version and delete the 
program directory before installing the new version.  
Refer to the To uninstall Actisense PC software 
section for full details.

3.	 If the program is contained within a zip file, extract 
the three files (‘<Product Name>.001,’ ‘<Product 
Name>.002’ and ‘setup.exe’) that are contained 
within the zip file using any available unzip program 
to a temporary directory (e.g. “C:\Temp”).

4.	 Double click on the ‘setup.exe’ program file and 
follow the on-screen instructions of the standard 
Windows™ install program. The install location can 
be change at this point, however, the default location 
is normally acceptable (refer to figure 4 and 5).
 
Once the install operation is complete, the temporary 
files and/or directory can be deleted. Keep the original 
zip file safe.

5.	 To start / run the program, use 
the Windows™ ‘Start’ menu and 
navigate to the installed program’s 
directory. There will be a program 
icon - double click on it (refer to 
figure 6 and 7).

Useful Tip: If you access the program 
regularly you can ‘copy and paste’ the 
program icon from the Windows™ ‘Start’ 
menu on to the desktop or the ‘Quick 
Launch’ short-cut bar to create a easy to 
access short-cut.

Figure 4 – Install options

Figure 5 – Installation complete

Figure 6 & 7 – ‘Start’ menu short-cuts
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To uninstall Actisense PC software
Replace the generic “<Product Name>” text below with 
the name of the actual software you are installing: “NDC 
Control Centre”, or “ActiPatch”.

1.	 If at any time you wish to remove the installed 
Actisense program, simply use the standard 
Windows™ ‘Start → All Programs → Actisense 
<Product Name> → Uninstall Actisense <Product 
Name>’ menu option to perform this operation (refer 
to figure 7).

2.	 Alternatively, there is a very convenient uninstall icon 
included in the program’s folder (see figure 6).

3. 	 Once the uninstall operation has been requested, the 
confirmation box (figure 8) will be displayed. Answer 
‘Yes’ and the uninstall operation will be performed 
automatically. After successfully uninstalling the 
Actisense PC software, the uninstall completion box 
will appear (refer to figure 9).

3.	 In addition, the program directory can also be deleted 
to completely remove the program. In this way all 
the program files will be uninstalled in a clean and 
complete manner.

If however, you are going to install a new version after 
this uninstall, you can keep the program directory 
and the configuration file stored within it. In this way, 
all the user settings you had for the previous version 
will be immediately available with the new version.

Figure 8 – Uninstall confirmation

Figure 9 – Uninstall complete
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Using the Control Centre
The Actisense NMEA Data Combiner hardware can be configured and monitored using its own dedicated Control 
Centre suite. This section provides a complete users guide to all the Control Centre’s features.

This program is currently only available for Windows platforms (98/ME/NT/2000/XP), however, it has been proven 
possible to use the Control Centre on a Mac running Windows emulation software.

Main window

Figure 10 – Control Centre main window (after hardware detected)

The Control Centre main window allows the user access to 
all the NDC hardware configuration and monitor features, 
and adjustment of the Control Centre’s actual appearance 
on screen.

The Control Centre is capable of displaying a large array 
of data and information, and not all will be of interest to 
every user. Therefore, the user can easily select which 
information / status windows are of interest and are visible, 
and which are not (hidden).

To meet the users specific requirements, any visible 
window can be repositioned on the screen by dragging it 
with the mouse. If a window is dropped (the left mouse 
button is released after the drag operation) close enough 
to an adjacent windows edge, it will snap to that windows 
edge. This allows for quick, easy and neat arrangement of 
the Control Centre’s windows.

From the main window the user can select what Baud rates 
the various inputs and outputs of the NDC need to be, and 
even change the input port priorities. Selection of these 
options is possible by using the standard Windows menu 
system (‘Options’ menu) or via a tab system (behaving 
just like tabs in a filing cabinet). Full explanation of these 
features is detailed in the following sections.

Any changes the user makes to the Control Centre’s 
appearance will be remembered for subsequent sessions, 
allowing the user to keep their favourite settings. Any new 
configuration settings must be downloaded to the NDC 
hardware before they can be remembered - this helps 
keep the Control Centre and NDC hardware in sync.

The main window has an ‘Exit’ control button to close the 
Control Centre program. Refer to the menu File → Exit for 
full details on the operation of the exit request.
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Initial hardware and software set-up
Important information - please read.

Figure 11 – Control Centre main window (before hardware detected)

To access all the NDC Control Centre configuration  
features, the Control Centre must first detect what type of 
NDC is connected. This allows the same Control Centre 
to be used for the NDC-1, NDC-2, NDC-3 and NDC-4 (as  
they all have different configuration and test options).

Before the NDC-4 hardware is detected by Control Centre, 
the main window will look like that in Figure 11 - with the 
sections ghosted out. 

Once detected, any disabled options that are available for 
the detected NDC type will become active and the main 
window will look like that in Figure 10.

To allow detection of the NDC hardware, perform the initial 
setup procedure:

1.	 Connect battery power (10 - 35v) to the NDC-4 and 
switch on the battery. The NDC-4’s LED will cycle 
through its standard start-up colours (‘red’, ‘amber’ 
and finally ‘green’). Refer to the Connecting to the 
battery supply section for more details.

2.	 If using an NDC-4: connect an RS232 cable from the 
PC to the NDC-4, as shown earlier in the manual. 
Alternatively, if using an NDC-4-USB: connect the 
provided USB cable to an available USB port. Refer to 
the Connecting to a Personal Computer section.

3.	 Select the PC Comm port number that the RS232 
cable was plugged into (or the USB port was issued 
by WIndows) from the options in the main windows 
‘Comms’ menu. The Baud rate will default to 38400 
Baud (the factory default), but will auto-Baud to the 
actual Baud rate if it has been changed.

4.	 The Rx and Tx ‘LED’s on the main window will flash to 
indicate that communication is in progress (between 
the Control Centre and the NDC-4 hardware). Once 
the hardware information has been received (and 
displayed), all the NDC-4 configuration and test 
options will be enabled.

If for any reason the hardware detection operation does 
not happen as described, check all connections are made 
as required and are secure.
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Pull-down menus
The main window has five standard pull-down menus.

File → Load / Save Configuration File:
The Control Centre will automatically save its appearance 
and all other settings to file “ControlCentre.ini” so that 
the same settings can be used in subsequent sessions.

If the user requires more than one configuration set up 
with unique Port Configurations, then each set up can be 
saved and loaded back from this menu. This is very useful 
for standardising vessel installations.

Note: Do not attempt to edit the “ControlCentre.ini” 
file by hand, as this can result in all the configuration 
settings being lost.

File → Exit:
Closes the Control Centre program. If any changes to 
the Port Configurations have been made, but not yet 
transferred to the NDC hardware, the user will be asked to 
confirm the exit request (as all alterations will otherwise be 
lost when the program closes).

Options → Configure Ports:
Displays the Port configuration tab of the main window. 
Refer to the Port configuration sub-section for full details 
on this feature.

Options → Configure Inclusion Lists:
Inclusion List configuration options are not currently 
available for the NDC-4. This functionality will be released 
as a free firmware upgrade on the Actisense website when 
finalised. Please monitor the Actisense website and / or 
sign up for the Actiscope newsletter.

Options → Test Hardware:
The Test hardware tab is not required / selectable for the 
NDC-4 (only required for the NDC-2 Multiplexer).

Comms → Comm Port 1-8:
Selects the PC communications port the NDC hardware is 
attached to. The Baud rate will default to 38400 (the NDC 
hardware default). If the NDC is not using the default Baud 
rate, the Control Centre will try all possible Baud rates until 
the correct one is found (this will take up to 12 seconds). 
The offline option closes the communication port.

Window → Control Centre Port Status:
Displays the Control Centre’s port status window. Refer to 
Control Centre Port status window for full details.

Window → NDC Hardware Port Status:
Displays the NDC hardware’s port status window. Refer to 
the Hardware’s Port status window for full details.

Window → NDC Hardware Connect Status:
Displays the NDC hardware’s connection status window. 
Refer to the Hardware’s Connect Status window for full 
details.

Window → NDC Hardware Information:
Displays the NDC hardware’s information window. Refer 
to the Hardware’s Information window for full details.

Help → Control Centre Help:
Currently unavailable (not selectable).

Help → About Control Centre:
Displays the Control Centre’s software version number 
and the Actisense contact information.

http://www.actisense.com
http://www.actisense.com/HTML/Contact/Actiscope.php
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Port Configuration tab
The Port configuration tab of the main window allows the user to select the priority and Baud rates of the NMEA and 
USB / RS232 input ports of the NDC-4 hardware, plus other useful features.

Figure 12 – Port Configuration tab

Why is there a need for Port Priorities?
Each of the five NMEA input ports can transfer anything 
up to 480 bytes of data per second, making a total of 1920 
bytes/second. The data combined output of the NDC is 
also forced (by the NMEA 0183 standard) to send a 
maximum of 480 bytes/second. Therefore, there exists the 
distinct possibility that there could be more data to send 
out than is possible to achieve. If this situation occurs the 
port priority system comes into operation.

This system stipulates that the highest priority input port 
will have the highest number of time slots in the combined 
output. The next lowest priority port has less time slots, 
down to the lowest priority input port that has only a few 
time slots. Each time slot allows one NMEA 0183 sentence 
to be sent until either no data remains (the usual case), 
or the transmit capacity has reached its maximum of 480 
bytes/second.

If the rate of data in to the NDC hardware continues at 
this very high level, then eventually some sentences (from 
the lowest priority channel first) will have to be dropped. 
If however, the rate drops below the maximum, then the 
sentence data will be sent at the next opportunity.

How to change port priorities and Baud rates
The port configuration tab consists of a vertical port 
priority list, a Baud rate pull-down list for each NMEA / 
USB / RS232 port, the P-code enable toggle control, and 
Get from Hardware, Reset to defaults and Send to 
Hardware buttons (refer to Figure 12).

Input Port Priority list:
Click on two inputs in turn to change their positions in the 
priority list. The topmost item has the highest priority and 
the item at the bottom, the lowest.

RS232 or IN/OUT 0 or USB Baud rate lists:
Select the required Baud rate for the appropriate port(s). 

Please note that the NMEA 0183 specification restricts 
the Baud rate for NMEA data to 4800 Baud. Therefore, 
any input port that has an NMEA device attached to it that 
cannot modify its Baud rate must remain at 4800 Baud 
(otherwise no data will be received). However, some 
NMEA devices (e.g. GPS units) do allow for the Baud 
rate to be increased to 9600 Baud, or even 38400 Baud 
(Hi-Speed NMEA). Only in these cases should the Baud 
rate of the appropriate port be changed from 4800 Baud to 
match that of the attached device.
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The USB or IN/OUT 0 Baud rate options are 4800, 9600, 
19200, 38400, 57600 or 115200 Baud. It is important to 
note that setting the USB / RS232 Baud rate to anything 
under 19200 Baud may reduce the bandwidth of this output 
below that of the total input bandwidth. This could result in 
random loss of NMEA sentences. Therefore, for normal 
operation, 38400 Baud is ideal, however, for exceptional 
requirements were the total input bandwidth is below 
100%, any of the available Baud rates can be used.

NMEA input 1 and the Combined NMEA output are two 
sides of the same port, and therefore share the same 
Baud rate (with options between 4800 and 57600 Baud).

NMEA inputs 2 and 3 also have the same Baud rate 
options of 4800 to 57600 Baud. Inputs 1, 2 and 3 can 
be used as hi-speed inputs (ideal for AIS transponders). 
Currently, setting the Baud rate to 57600 will restrict all 
other NMEA inputs to 4800 Baud - to help keep the total 
bandwidth to a manageable level.

NMEA input 4 is fixed to the standard 4800 Baud rate.

It is worth noting, that the NDC-4 receives and buffers all 
the NMEA  0183 sentences from all 5 inputs (4 NMEA 0183, 
and 1 USB / RS232), and then as a totally independent 
operation, it re-sends the required NMEA 0183 sentences 
out its 2 ISO-Drive outputs.

As these two operations are independent, the Baud rates 
of all the inputs and outputs can also be independent, that 
is to say, different - the inputs and outputs can all have 
different Baud rates (with the except of Input 1).

Extra ARL P-codes:
Toggles the enable/disable 
state of the extra ARL 

P-code sentences on the RS232 port. These P-codes are 
used by Control Centre to determine which NDC input 
supplied which piece of NMEA data. In this way, Control 
Centre can show what data came from channel 1, channel 
2, etc. This ability is also open to any other PC program. 
For example, an NDC with 4 digital NMEA depth sounders 
connected to it could have the 4 individual depth values 
shown on a PC screen in representative positions (bow 
starboard, bow port, stern starboard and stern port).

If in the unlikely event however, the USB / OUT 0 port is 
connected to an electronic device (e.g. chart plotter) that 
cannot ignore the P-codes (as it should by default), then 
these P-codes can be disabled to aid compatibility.

Note: As the Control Centre requires the extra Actisense 
P-code sentences to operate correctly, it will temporarily 
turn them on when it first connects to the NDC-4. When the  
Control Centre software is closed, the NDC-4 will revert 
back to the user-stored configuration settings, and the P-
code sentences will stop being transmitted (if configured 
as such by the user as disabled).

Clone output mode:
Toggles the enable/disable 
state of the data Clone 

output mode on the USB/OUT 0 port. When output port is 
in Clone output mode, the data output will be a clone, or 
copy, of the data output from the NMEA Combined output 
(OUT 1). That is to say, the data output will have been 
filtered just like the NMEA Combined output data is. 
 
This is useful if you need to supply an NMEA device with 
filtered NMEA data that will only accept RS232 signal 
levels on its input, or requires a higher Baud rate.

When Clone output mode is disabled, the USB/OUT 0 
output will contain all data received on all 5/4 of the NMEA 
inputs (no filtering applied).

Delete duplicates:
Toggles the enable/disable 
state of the useful Delete 

duplicates option. When enabled, any duplicate NMEA 
sentences found in the receive buffer that are deemed  safe 
to delete older versions (duplicates) will be deleted. This 
intelligently reduces the output data when too much data 
is coming through the input channels. For example, if two 
depth sentences are in the buffer ready to be transmitted, 
there is normally no point in transmitting the older depth 
value, as the newer one has replaced all previous ones.

However, for special systems that do not want this feature 
(and can guarantee that there will not be more than 100% 
total loading), this feature can be disabled.
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Get from hardware:
Reads the current Port Configuration 
information, for all channels, from the 
connected NDC hardware. This will 
overwrite any current settings held by the 

Control Centre’s Port Configuration; if the current settings 
must be remembered, the File → Save Configuration 
file main window menu option should be used before 
requesting this operation.

Reset:
Returns all Port Configurations to the 
factory defaults – port priorities match 
channel numbers (port 1 has highest 
priority and port 4 has the lowest), NMEA 

Baud rates are set to 4800 Baud, USB/RS232 Baud 
rate set to 38400 Baud and the extra ARL P-codes are 
enabled.

Send to Hardware:
Finalises the Port Configuration editing 
operation. If any alterations to the port 
configuration settings have occurred 
the Control Centre will now attempt to 

download the new settings to the attached Actisense 
NDC hardware.  The Flash Hardware Control window 
will appear for the brief duration of the download (normally 
one to two seconds).

Note: Pressing any of the threes buttons above will only 
affect the Port Configuration settings.

Set-up Procedure
1.	 The USB / RS232 communication port defaults 

to 38400 Baud - normally more than capable of 
transferring the received data of all four NMEA input 
ports. When connected to a Personal Computer 
there should not be any reason to change this Baud 
rate. However, if it is required to connect the NDC 
hardware to an RS232 compatible device that does 
not support the Baud rate of 38400, then the rate 
can be changed. Left click on the USB / RS232 Port 
Baud rate control’s down arrow to display the list and 
then select the required Baud rate value.

2.	 The proprietary Extra ARL P-code sentences sent 
by the NDC hardware are completely benign and 
should be ignored by all other manufacturer devices. 
The Actisense software programs (Control Centre 
and ActiPatch) use these sentences to perform 
certain operations that enhance their control over the 
NDC hardware and are therefore important. There 
should not be any reason for requiring that these 
sentences be disabled. However, as Actisense 
believes in offering complete control over its products, 
it is possible to enable/disable these sentences by 
clicking on the Extra ARL P-codes control.

3.	 The OUT 0 / RS232 output defaults to normal output 
mode - that is, with the Clone output mode option 
disabled. If however, it is required to apply the NMEA 
filter settings to the OUT 0 data, enable this option.

4.	 As detailed above, the NMEA 0183 standard 
determines the Baud rate of 4800. If however, to make 
the NMEA input compatible with special devices that 
offer a different Baud rate, the rate can be changed 
by left clicking on the NMEA Port 1-3 pull-down lists. 

	 NMEA Port 4 does not have a pull-down list as it is 
fixed at 4800 Baud.

5.	 To aid memory, it is normal to keep the port priorities 
in the same order as the port numbers - port 1 has 
highest priority and port 4 the lowest. However, if for 
some reason the port priorities require changing and 
it is inconvenient to alter the hardware connections, 
the port priorities can be changed using the Input 
Port priorities list.

6.	 If the NDC hardware has not been detected yet, the 
Control Centre will not allow the configuration transfer. 
If this happens check all cable connections, Control 
Centre communication settings (port number and 
Baud rate) and battery power to the NDC hardware 
(the diagnostic LED should be lit and either a ‘Green’ 
or ‘Amber’ colour).

7.	 When the Control Centre has detected the NDC 
hardware (the hardware information will be displayed 
in the NDC Hardware Information window), clicking 
the Send to Hardware control button will start a 
transfer of the new Port Configuration data to the 
hardware. This process can be monitored on the 
Flash Hardware Control and NDC Hardware 
Connection Status windows (normally for advanced 
users only).

8.	 The Flash Hardware Control window will display the 
success status of the transfer and then disappear.

9.	 If at any time you would like to return the Port 
Configuration settings back to their defaults, press 
the Reset to defaults control button followed by the 
Send to Hardware control button.

Note:
1.	 The USB / RS232 output is unaffected by the NMEA 

Port Priorities, and typically retains all received data 
– as this port has a high enough transmit bandwidth/
capacity to handle all NMEA data received.

2.	 Pressing any of the three control buttons on the 
Port  Configuration Tab will only change / download / 
retrieve the port configuration values.
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Inclusion List configuration tab
The Inclusion List configuration tab of the main window allows the user to select which NMEA sentences are to be 
included in the onward data transmission from the NMEA Data Combiner. Each of the four NMEA input ports and the 
USB input port have their own Inclusion List, so that each can be tuned separately to match its connected device.

Figure 13 – Inclusion List configuration tab

Why is there a need for Inclusion Lists?
Each of the 5 input ports can transfer anything up to 480 
bytes of data per second, making a total of 1920 bytes/
second. The data combined output of the NDC is also 
forced (by the NMEA 0183 standard) to send a maximum 
of 480 bytes/second. Therefore, there exists the distinct 
possibility that there could be more data to send out than 
is possible to achieve - thus, some data may require 
removal to balance this equation. The Actisense™ NDC-
4 achieves this reduction in an intelligent manner with 
Inclusion Lists and Port Priorities.

Is some NMEA data really unnecessary?
Many NMEA instruments output a large number of 
sentences every period (usually 1-3 seconds), some of 
this data is of absolutely no use to the average boat owner, 
and just clogs up the NMEA network. Most GPS units are 
especially guilty of this and not all allow the user to reduce 
the number of unwanted sentences that are transmitted. 
Of those that do, the procedure can often be tricky and 
time consuming.

The Actisense™ NDC-4 can filter the incoming NMEA 
data to remove any sentences deemed unnecessary.

For example, most GPS units automatically output the 
‘GSV’ sentences (normally 2 but could be as many as 4), 
which give details of all the satellites that are currently in 
view. All of this information is of no use to 99% of users, 
but this alone can use up to 5% of the available NMEA 
bandwidth/capacity.

The Actisense™ NDC ‘Inclusion List’ default is to allow all 
sentences through. The user can modify these lists using 
a simple ‘tick-box’ panel from within the Control Centre.

How to change the Inclusion Lists
The Inclusion List configuration tab consists of two groups 
of sentence tick boxes, a box indicating the total number 
of selected sentences, an NMEA channel selection pull-
down list, and Get from hardware, Reset to defaults and 
Send to Hardware control buttons (refer to Figure 13).

Channel selection list:
Determines which input channel (port) 
has its Inclusion List displayed for 
editing with the tick-box controls in the 
main section to the left.
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Main (left) tick-box area:
Each NMEA 0183 sentence has its own individual tick-
box, and is intended for the advanced user to fine tune 
the selection to exactly what is required (as this requires 
detailed knowledge of NMEA 0183 sentences).

Sentence Groups (right) tick-box area:
To make selection of NMEA 0183 sentence’s easier, 
all sentences of a particular type have been collected 
together, and is primarily intended for the novice user who 
does not know which sentences contain what information. 

The NMEA sentence collections are designed for quick 
list configuration; each collection influences all the NMEA 
sentence tick-boxes in the main (left) area that contain the 
selected information.

The tick-box operation is straightforward: if the box is 
ticked, the corresponding NMEA sentence will appear on 
the combined NMEA output. Conversely, if the box is not 
ticked, that NMEA sentence will be blocked and not appear 
on the combined output.

To completely disable the Inclusion 
List for a particular channel, 
click on the Clear all sentences 
button. The list status indicator will 
then change from the green List 
Enabled to red Pass all data.

The Sentence Total box will also show that ‘0’ sentences  
are selected.

Once disabled (and Pass all data displayed), all NMEA 
sentences will be passed to the NMEA combined output 
- no filtering will occur on this channel. This is only useful 
when trying to pass an NMEA sentence that is not available 
for selection in the Inclusion List and is not normally used.

The buttons Clear all sentences and Set all sentences 
are useful to quickly reset or set all tick marks. This allows 
for quick configuration of the Inclusion List without having 
to click on every tick box. For example, if only a couple 
of sentences are required to be set, press the Clear all 
sentences button followed by selecting the couple of 
required sentence IDs.

Sentence Total:
The total number of NMEA sentences currently 
selected / enabled for the current channel / port 
is displayed in the bottom right corner. This is 
purely for user information and interest.

Get from Hardware:
Reads/retrieves the current Inclusion 
List information, for all channels, from 
the connected NDC hardware. This will 
overwrite any current settings held by 

the Control Centre Inclusion Lists; if the current settings 
must be remembered, the File → Save Configuration 
file main window menu option should be used before 
requesting this operation.

Reset to defaults:
Returns all channel Inclusion Lists to the 
factory default – all Inclusions Lists are 
disabled on all channels, which allows 
all sentences to be passed by default.

Send to Hardware:
Finalises the Inclusion List editing 
operation. If any alterations to the list 
have occurred, the Control Centre will 
now attempt to download the new settings 

to the attached Actisense™ NDC hardware. The Flash 
Hardware Control window will appear for the duration of 
the download and the details of the conversation can be 
viewed in the NDC Hardware Connection Status window 
(advanced users only).

Note: Pressing any of the threes buttons above will only 
affect the Inclusion List settings - all Port Configuration 
settings will remain unaffected as they are controlled by 
their own independent set of buttons.
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Set-up procedure
1.	 Remembering that the channel’s have a priority 

level (that only has a effect during very high loads), 
choose which device to connect to which channel. 
Place the most important device on channel 1 and so 
on. If the ‘Inclusion Lists’ are tuned to allow only the 
required data of each device through, then the port 
priorities will normally not come into operation (as the 
maximum output rate will usually not be exceeded).

2. 	 Starting with channel 1, place a tick next to all required 
NMEA sentences (using the individual tick boxes, the 
grouped tick boxes or a combination of both), by left 
clicking on the text or box with the mouse pointer.

3.	 Perform the same operation 
for any other channels that you 
intend to use. Use the Editing 
Channel selection list to change 
which channel is active - left click 
on the controls down arrow to 
display the list and then select 
the required channel number. 
Any combination of channels can 
be used – for example, in a two-
device set-up channel’s 1 and 3, 
or 2 and 3 etc. could be used.

4.	 If the NDC hardware has not been detected yet, the 
Control Centre will not allow the configuration transfer. 
If this happens check all cable connections, Control 
Centre communication settings (port number and 
Baud rate) and battery power to the NDC hardware 
(the diagnostic LED should be lit and either a ‘Green’ 
or ‘Amber’ colour).

5.	 When the Control Centre has detected the NDC 
hardware (the hardware information will be displayed 
in the NDC Hardware Information window), clicking 
the Send to Hardware button will start a transfer 
of the new Inclusion List data to the hardware. This 
process can be monitored on the Flash Hardware 
Control and NDC Hardware Connection Status 
windows (for advanced users only).

6.	 The Flash Hardware Control window will display the 
success status of the transfer and then disappear.

7.	 If at any time you would like to return the Inclusion 
List settings back to their defaults, press the Reset 
to defaults control button followed by the Send to 
Hardware control button.

Note:
1.	 The OUT 0 / RS232 / USB output is unaffected by 

the NMEA Inclusion Lists and typically (when Clone 
output mode is disabled) retains all received NMEA 
data – as this port’s high transmit bandwidth/capacity 
can handle all the NMEA data received.

2.	 Pressing any of the three control buttons on the 
Inclusion List Tab will only change / download / 
retrieve the inclusion list configuration values. The 
Port configurations will remain unchanged.
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Please note that during this updating process, it is vital that 
the Control Centre and NDC hardware are not interrupted. 
Therefore, the following precautions are suggested:–

1.	 Ensure there are no programs active/running on the 
PC other than the Control Centre.

2.	 Check that the USB / RS232 cable between the PC 
and the NDC hardware is secure.

3.	 Confirm that the battery supply to the NDC hardware 
is secure.

If the Flash hardware operation is interrupted, the Port 
Configurations could become corrupted. The user 
should identify and remove the reason for the previous 
interruption before re-attempting to flash the hardware 
again (by pressing the Send to Hardware control button 
on the appropriate tab).

The Flash Hardware window consists of four LED’s that 
indicate the flash operations current status, a progress bar 
indicating percentage completed of the current stage, and 
a flash program counter that indicates how many times the 
NDC hardware’s Inclusion List has been re-programmed.

The Success LED indicates the final outcome of the data 
transfer. If it does not light up green, the NDC Hardware 
Connection Status  will indicate a more detailed cause 
and the process should be performed again.

Flash Hardware window
The Flash Hardware window is displayed for the duration of the Port Configuration update operation.

Figure 14 – Flash Hardware Control window

Advanced Features
The following windows and/or tabs will only be of interest to the advanced user, as they are not vital for the configuration 
of the NDC hardware. They do however, explain the useful diagnostic and monitoring features available.

These advanced windows are hidden by default, and all novice users should advance past this section to the Using the 
NDC ActiPatch section that follows.
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This includes data received (from the NDC hardware) 
and data sent (to the NDC hardware), and the bytes-per-
second transfer rate / buffer loading rate for both directions 
of the communications port.

The Channel selection list 
allows the user to choose 
which channel’s NMEA data 
is displayed in the Received 
NMEA Data window.

This enables each NDC 
input to be analysed and the 
NMEA data checked. For 

example, this is very useful in allowing the user to view 
an NMEA channel’s data and prove that the NMEA device 
connected to that NDC input is functioning correctly.

This window should be the first port-of-call when trying to 
diagnose a problem with the NMEA system connected to 
the NDC-4. Contact a qualified marine electronic installer 
if you require hands-on help with understanding the NMEA 
0183 data seen in this window. In addition, there is a very 
good source of NMEA information contained within the 
NMEA 0183 information sheet document available on 
the Actisense website.

The current USB / RS232 
Baud rate being used for 

communication between the Control Centre and NDC 
hardware is displayed here for the user’s information.

The Received NMEA Data window is valuable in 
monitoring the performance of the NDC hardware, and as 
a diagnostic tool for pinpointing:

A port overload condition - this is when the maximum •	
data transfer rate of a port is exceeded, and data is 
being dropped/deleted randomly as a result.

A data corruption condition - this is either when the •	
signal level of NMEA 0183 data being received is 
marginal and/or suffering from interference, or when 
interference is occurring between the NDC-4 and the 
computer running Control Centre.

When all data is being processed as required.•	

Control Centre Port Status window
The Control Centre status window displays all information relating to the communications port open between the Control 
Centre and the NDC-4 hardware.

Figure 16 – Control Centre Port Status window

http://www.actisense.com
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Hardware Port Status window

Figure 17 – Hardware Port Status window

The NDC hardware status window, like the Control Centre 
Port Status window, displays bytes-per-second transfer 
rates and buffer loading rates for a number of ports. 
(expressed as a percentage of the maximum) However, 
these values relate to the ports on the NDC hardware – 
the four NMEA input ports, NMEA combined output port 
and the USB / RS232 input/output port.

This data is also valuable in monitoring the performance of 
the NDC hardware, and as a diagnostic tool for pinpointing 
an overload condition (refer to Control Centre Port Status 
window for more details).

Hardware Connection Status window

Figure 18 – Hardware Connection Status window

The NDC hardware connection status window displays 
all information related to the connection status between 
the Control Centre and the NDC hardware. This includes 
all handshaking and data transfer information required 
for flash programming the NDC hardware during the Port 
configuration data updates.

This information is normally only useful when speaking 
with Actisense technical support engineer and can be 
ignored at all other times.

Reset:
Resets the connection status messages 
currently displayed, clearing the window.
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Hardware Information window

Figure 19 – Hardware Info window (NDC-4)

Figure 20 – Hardware Info window (NDC-4-ASW)

The NDC hardware information window displays the 
information received from the NDC hardware.

This information Includes:-

1.	 Hardware Serial ID number:
	 The unique serial identification number given to each 

Actisense product. This number is used to identify 
each NDC-4 unit in our records.

2.	 Bootloader & Main (software) program version:
Version numbers of the bootloader and Main 
application software programs. If the Main program’s 
version number is older (less than) that of the currently 
available NDC ActiPatch, the latest NDC ActiPatch 
should be downloaded from  the Actisense website 
and the NDC unit updated.

3.	 Bootloader & Main program date and time:
Dates and times that the bootloader and Main 
Application programs where updated / ‘flashed’ into 
the hardware’s memory.

4.	 Total operating time:
The total time that the NDC hardware has been 
operating since new.

5.	 ARL model code:
The Manufacturer’s Model ID. Model “10” determines 
the hardware as an NDC-4 module.

6.	 ARL hardware version:
The Manufacturer’s hardware revision number. 
Version “1.00”, in combination with the Model ID “10” 
determines that this NDC is actually an NDC-4-A 
product variant.

7.	 Operating mode:
	 Current NDC-4 operating mode - either ‘Combiner’ 

or ‘Autoswitch’. Confirms how the NDC-4 is currently 
processing any received NMEA data.

8.	 Flash program counters:
Not used for NDC-4’s and will remain blank.

Reset:
Resets the hardware information displayed 
and requests the current information from 
the NDC hardware (thus refreshing the 
displayed information).
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Configuration of AIS

Figure 21 – AIS Configuration with 38400 Baud Rate

NDC Control Centre, supplied on the CD (or available for 
download from Actisense website) allows a quick set-up 
for AIS using the configuration file included.

From the menu select ‘File’ → ‘Load Configuration File’ 
and select ‘NDC-4 config for AIS.ini’ file from the install 
directory. This will set input port 2 to the AIS required Baud 
rate of 38400, and configure OPTO IN 2’s Inclusion List to 
filter out all AIS data from being sent to ISO OUT 1 which 
is typically kept at 4800 Baud. 

The use of AIS at Baud rates lower than 38400 cannot 
be recommended as this could cause random AIS 
target data to be lost in areas of high target density.

To enable these settings on the NDC-4 click on the ‘Send 
to Hardware’ button on both the ‘Port Config’ and ‘Inclusion 
List’ tabs.

The AIS device should then be connected to the NDC-4’s 
‘OPTO IN 2’ as shown in Figure 21, with any other talkers 
connected as required. The device for receiving the AIS 
data (chart plotter or PC) should be connected to ‘ISO 
OUT 0’, or the USB port.

The remaining ports can be re-configured by the user as 
needed using NDC Control Centre. Refer to the ‘Using 
NDC Control Centre’ section for full detailed information 
on how to use the NDC Control Centre.

Setting up the Hardware for AIS
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The NDC-4-ASW Autoswitch
The Actisense NMEA Data Multiplexer / Combiner / 
Autoswitch (NDC-4) has been designed with the ability to 
operate as a Multiplexer / Combiner OR an Autoswitch.
 
For systems that have multiple NMEA devices of an  
identical type (e.g. two GPS’s or two depth sounders), 
automatic selection of the highest priority device is 
normally a vital requirement. However, the NMEA 0183 
standard has no method of automatically switching 
between different devices, so this requirement is usually 
fulfilled with a manual changeover switch: not a very good 
solution, but the only one available until now.

If the NMEA data from two (or more) devices are simply 
combined together, the NMEA listener(s) will not be able 
to differentiate between the various sources and will get 
very confused, often jumping between them. If this creates 
a ‘jumping’ position fix, vessel safety is seriously affected.

The NDC-4 Autoswitch mode is the perfect solution to 
this problem - automatically selecting a single device 
from the multiple ‘same data type’ devices available.
 

Autoswitch mode will automatically select the highest 
priority device from up to 4 connected input devices, with 
NMEA port 1 as the highest priority through to NMEA 
port 4 as the lowest. This creates a system capable of 
automatically selecting the next priority device if the higher 
priority device fails for one of three reasons:

A complete failure to send any NMEA data1.	
An invalid NMEA sentence checksum2.	
If the validity flag(s) contained within the received 3.	
NMEA sentence indicate that this data is not valid and 
should only be used with caution.

With the addition of two fully Baud rate configurable 
outputs protected by ISO-Drive technology, that can 
also incorporate NMEA filtering to remove any unwanted 
sentences before the switching process, the Actisense 
NDC-4 Autoswitch mode is the most flexible available.

Having the ability to filter out NMEA data before the 
autoswitch process can be particularly useful to avoid 
unwanted sentences from causing the Autoswitch to 
change input channels due to invalid data, leaving only the 
required sentences to switch on.

If ordered as an Autoswitch, the NDC-4 will be pre-
configured as an NDC-4-ASW and be ready to work out of 
the box. Alternatively, any NDC-4 can be configured using 
the NDC Control Centre to operate in Autoswitch mode.

Setting the NDC-4 as an Autoswitch
The NDC-4 can easily be changed between being a NMEA 
Data Multiplexer / Combiner and an NMEA Autoswitch 
using NDC Control Centre.

In the ‘Port Configure’ tab click on the button labelled 
“Change To Autoswitch” to change the NDC-4’s operation 
mode to Autoswitch. 

Figure 22 – “Change To/From Autoswitch” message

A warning message will be displayed, requesting that the 
user confirm the request to change to Autoswitch mode. 
Selecting “Yes” will automatically send the new configuration 
to the unit, and the NDC-4 will now Autoswitch its inputs 
instead of Combining them.

To revert back to Combiner mode, click on the (same) 
button (now labelled “Change To Combiner”). Again, the 
user must confirm the operating mode change is required 
and the NDC-4 will now Combine its inputs instead of 
Autoswitching them.
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This program is currently only available for Windows 
platforms (98/ME/NT/2000/XP), however, it has been 
proven possible to use NDC ActiPatch on a Mac running 
Windows emulation software.

The NDC ActiPatch window consists of a Hardware 
Connection Status text box, Hardware status LEDs, 
Current Version (Main ID) and New Version (Patch ID) 
text boxes, and the Program (Flash) control button.

The NDC hardware should be connected to the PC 
communications port (RS232 or USB) and if not using 
a USB connection, a battery supply is also required, as 
per the instructions in the Connecting to a Personal 
Computer section and Figure 3 (RS232, USB and Battery 
connections diagram).

Pull-down menus
The main window has three standard pull-down menus:-

File → Program the Target:
This option will become active / selectable when a 
successful connection has been made to the ‘target’ 
(NDC-4). The Program button is normally used to start the 
reprogram operation, but this menu option can be used 
instead and is included for completeness.

File → Exit:
Closes the NDC ActiPatch program.

Using the NDC ActiPatch
The  Actisense NDC-4 firmware can be easily and quickly updated using the  Actisense NDC ActiPatch. The program 
has a simple look, as the flash update process has been completely automated for a trouble-free operation.

Figure 23 – NDC ActiPatch window (searching for NDC)
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Comms → Comm Port 1-10:
Selects the PC communications port that the NDC 
hardware is attached to (via the RS232 or USB cable).

ActiPatch will automatically match the NDC hardware’s 
Baud rate if it has changed from the 38400 Baud default. 
This auto-baud matching process could take up to 20 
seconds to achieve. The result of this automatic feature is 
that the user does not need to select the Baud rate.

Once a Comms port has been selected (or remembered 
from a previous session), ActiPatch will immediately 
attempt to connect to the attached NDC hardware - 
no further user action is required until the successful 
connection has been made.

Help → Help with reprogramming:
Displays a window with useful information about how to 
perform the reprogramming operation if the user cannot 
reference this more complete support document.

Help → About:
Displays the NDC ActiPatch’s software version number 
and the Actisense contact information.

Buttons, LEDs and Displays

Connection Status text display:
Displays all handshaking and data transfer information 
required for flash programming the NDC hardware 
during the firmware update process. For most users this 
information can be ignored, and will only be useful if there 
are problems in reflashing the attached NDC.

Serial ID (Unique identification number):
Displays the Serial ID of the NDC that is attached and 
successfully connected to. Every Actisense product has its 
own unique serial identification number.

Main ID (Current Version):
Displays the version of firmware currently resident in 
the NDC hardware’s Flash memory. This information is 
received from the NDC hardware when ActiPatch detects 
the NDC hardware’s presence.

Patch ID (New Version):
Displays the version of firmware that ActiPatch can 
upgrade the NDC hardware to. This number must normally 
be greater than the Main ID (Current Version) for an 
update to be required.

If the Patch ID (New Version) is older or equal to the 
Current Version, then ActiPatch will display a warning 
message that must be acknowledged before the reflash 
operation can begin.

Figure 24 – “Hardware already up to date” message

There is normally nothing to be gained, and perhaps  
functionality and performance of the NDC to be lost, 
if an older firmware version is used to reprogram the 
NDC. However, for rare occasions when instructed by an 
Actisense support engineer, this ‘stepping back’ of the 
firmware can be achieved.
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Connection Status LED’s:
The four status LED’s inform the 
user what stage the reprogramming 
operation is currently at.
 
Initially no LED’s will be lit. Once a 
successful connection is made to 
an NDC-4 unit, the Connected LED 
will light. During the reprogramming 
operation, both the Erasing and 

Programming LED’s will become lit, and finally, once the 
operation is complete, the Success LED with light. It is 
normal for the success LED to only stay lit for a second or 
two, after which it will turn off.

Data Communication LED’s:
These LED’s indicate if any data 
communication to the NDC (Tx) and 
from the NDC (Rx) is happening. 
They are very useful in helping to 
diagnose simple connection issues.

Program command button:
Becomes available/selectable once 
connection to an NDC-4 unit is 
achieved. This button Initiates the 
flash update of the NDC hardware. 

At this point the diagnostic LED on 
the NDC-4 will be solid red.

The reprogramming operation
Once the program button has been pressed, the 
reprogramming operation cannot (and must not) be 
stopped and must complete successfully - otherwise the 
NDC hardware will become unusable.

To this end the user must take all precautions to prevent 
loss of battery power to the NDC, or communications with 
the NDC hardware. If there is a failure with either of these, 
the reprogramming operation must be restarted - once the 
original issue has been removed.

Progress Bar:
During the reprogramming operation the progress bar will 
be visible. This indicates how much of the two stages has 
been completed and how much is left to do.

During the Erasing operation, the bar is red showing the 
Flash memory being erased (cleared).

During the Programming operation, the bar is green (with 
a red background), showing the new firmware being written 
to the flash memory. Once the green progress bar reaches 
the far right hand side, the operation will be complete and 
the Success LED will light for a second or two.

The successful completion of the firmware update process 
can be further checked by looking at the ID display area. 
The Main ID (Current Version) and the Patch ID (New 
Version) will now be identical - proving that the new 
firmware is now safely inside the NDC-4.
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LED Colour /
Flash Count Mode / Error condition Required user response

Normal operation modes The sequence below indicates a successful power-up of the 
NDC-4 and the commencement of data combining.

Red, 
No flashing

Start-up mode,
No error

No response required. A normal operation mode that should 
last for no more than 1.5 seconds. Any longer indicates an 
error with the main program.

Red, 
No flashing

Flash updating mode,
No error

No response required. LED will stay red for the duration of the 
flash update operation (using Flash Centre). Once operation 
complete, NDC hardware will be automatically reset.

Amber,
No flashing

Initialise and self-test mode,
No error

No response required. A normal operation mode that follows 
after the Start-up mode and should last for approximately 1 
second.

Green,
No flashing

Normal and no data mode,
No error

No response required. A normal operation mode that follows 
the Initialise and self-test mode. Indicates that no error was 
detected during the self-test operation. 

Also indicates that no data is currently being received by the 
NDC-4 hardware.

Green,
Flashing 

(1-10 per second)

Normal and data Rx mode,
No error

No response required. A normal operation mode that indicates 
that data is currently being received (on at least one channel) 
by the NDC-4 hardware. Flash rate proportional to Rx rate.

Error conditions

If the error persists, the NDC-4 unit should be returned to 
Actisense (refer to the Company Information section). 

Please contact Actisense before returning the unit in 
order to obtain a Returns form. Any returns sent without a 
Returns form will incur a delay in being processed.

Amber,
Flashing

(Once every 4 
seconds)

Error trap mode,
EEPROM memory error

An error with the EEPROM memory has been detected during 
the self-test mode.

Reset the NDC-4 hardware.

Table 1 – Diagnostic LED colours

Troubleshooting guide
This guide will concentrate on all relevant troubleshooting issues above simple cable connection faults. Therefore, the 
cables between the NDC-4 hardware and any other devices should be checked as a matter of course, before continuing 
with this guide.
 
Diagnostic LED
The NDC-4 hardware supports a tri-colour diagnostic LED that indicates the current operating mode of the hardware, or 
if an error has been detected during the self-test initiation process. Table 1 details what each LED colour represents and 
if any user interaction is required.
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Control Centre Error Status window
The Control Centre will display any error information received from the NDC-4 hardware in a window like that in Figure 
22. If this window is displayed, follow the message instructions carefully and then if the fault persists, contact Actisense 
(refer to the Contact Information section).

Figure 25 – Control Centre Error Status window
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Specifications
The NDC-4 ISO-Drive output is a very flexible output that is RS485, RS232, RS422 and NMEA 0183 compatible.

Parameter Conditions Min. Max. Unit

Supply
Supply voltage External power supply 8 35 V

Supply current from external source 
(see note 1)

Supply voltage = 12v 30 40 mA

Supply voltage = 24v 15 20 mA

Supply voltage USB powered 4.75 5.25 V

Supply current from USB (see note 1) Supply voltage = 5v 67 75 mA

Opto-isolated Flexible Input

Input voltage between +/-
Logical ‘1’/stop bit -15.0 0.5 V

Logical ‘0’/start bit 4.0 15.0 V

Input current Maximum is under +35v overload 
condition, Min @ 2.0v input level 1.6 9.0 mA

Differential input voltage Required level for NMEA to be 
detected 1.8 2.0 V

Galvanic isolation Between input & output 2500 V

Overdrive protection 40 V

Input Baud rate 4800 57600 bps

ISO-Drive Flexible Output

Output voltage between ISO Out +/A and 
ISO Out -/B (under no load)

Logical ‘1’ -4.6 -5.0 V

Logical ‘0’ 4.6 5.0 V

Output current at max load of 100 ohm At maximum load, differential drive 
voltage reduces to 2.1v - 21 mA

Output short circuit current (note 2) Due to short circuit protection 50 55 mA

Galvanic isolation From Opto-input and (USB) ground 1500 V

Output Baud rate 115200 bps

Data propagation delay Under no-overload conditions 1.0 100 ms

General
Ambient temperature -20 +70 °C

Table 2 – NDC-4 specifications

All specifications are taken with reference to an ambient temperature (TA) of +25°C.

Note:
1.	 Current consumption measured under no-load conditions.
2.	 Short circuit may be applied indefinitely.  The ISO-Drive output may be short-circuited directly to a 30 volt battery 

supply without damage.  A maximum current of 50mA will flow due to “polyfuse” auto-resetting fuse technology 
being used in each output.
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System block diagrams

Figure 26 – NDC-4 in ‘Combiner’ mode signal flow block diagram

Figure 27 – NDC-4 in ‘Autoswitch’ mode signal flow block diagram
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Save your NDC configuration options here

NMEA Input (1-4) NMEA Device connected Baud rate

USB / RS232 Input & Output NMEA Device connected Baud rate

NMEA Combined Output NMEA Device connected Baud rate
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Active Research Limited
5, Wessex Trade Centre
Ringwood Road
Poole
Dorset
UK
BH12 3PF

Telephone:		  01202 746682  (International : +44 1202 746682)
Fax: 			   01202 746683  (International : +44 1202 746683)

Actisense on the Web: For advice, support and product details

E-mail:			   support@actisense.com
Website:		  www.actisense.com

“Actisense” is a registered trademark of Active Research Limited.

Company Information

Order codes:

NDC-4 Standard NDC-4 (5 isolated inputs, 2 ISO-Drive outputs)
NDC-4-USB USB capable NDC-4 (4 isolated inputs, 2 ISO-Drive outputs & USB bi-directional 

PC data port)
NDC-4-AIS Standard NDC-4 preconfigured for AIS use (Input 2 set to 38400 Baud and Input 

2’s NMEA Filter list set to block AIS data going out standard Baud rate Output 1)
NDC-4-ASW Standard NDC-4 preconfigured for Autoswitch use (Operating mode set to 

“Autoswitch” instead of standard “Combiner” mode)

mailto:support@actisense.com
http://www.actisense.com
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